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Ashlar-Vellum Cobalt Only
Basic Geometric Constraints Tutorial
This tutorial demonstrates how to set up geometric constraints and equations to drive 
geometry in Cobalt's Digital Constraint Manager. 
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Creating the Base Extrusion
1. After launching Cobalt, select Constraints from the Window menu to bring up 

the Constraints palette. 

2. Select Sketch Mode from the Constraints palette then click anywhere in the 
drawing window to create a new sketch. 
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Notice that a new Exit Sketch Mode button appears in the drawing window 
along with a sketch mode axis. The palettes which can be used within the 
sketch mode are displayed. 

3. Select the Connected Line tool from the Tool palette.

4. Start drawing a vertical line somewhere below and to the left of the Sketch 
Mode origin which ends somewhere above and to the left. As soon as you click 
to generate the endpoint of this line, a little V symbol appears at the midpoint 
to signify that a vertical constraint has been automatically added to the line.
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5. Next draw a Horizontal line which starts at the endpoint of the previous line and 
extends above and to the right of the sketch mode origin. Click to generate the 
endpoint of this line. 
A little H symbol appears at the midpoint to signify that 
a horizontal constraint has been automatically added to 
the line. A little box symbol appears where the two lines 
meet. This shows that a coincident constraint has been 
applied between the endpoints of the two lines. 

6. Holding down the ALT key (Macintosh) or CTRL key 
(Windows), draw a tangent arc which begins at the line just created and 
extends vertically down until the Drafting Assistant displays an intersection 
with the starting point of the first created line. 
As soon as you click to generate the endpoint of 
the tangent arc, a little box symbol appears 
where the line and the arc meet. Also a little 
circle symbol appears at the same point, 
signifying that a tangent constraint has also 
been applied between the line and the arc.

7. Complete the profile with a line which begins at 
the endpoint at the arc just created and extends to the starting point of the first 
line. Do not forget to double click the last point to close the profile. 
After double clicking to generate the endpoint of 
the line, a little box symbol appears where the 
line and the arc meet to show that a coincident 
constraint has been applied between the 
endpoints of the arc and the line. A little circle 
symbol appears at the same point, showing that 
a tangent constraint has been applied between 
the arc and the line. In addition, a little box 
symbol appears where the line meets with the 
first line created to indicate that a coincident 
constraint has been applied between the 
endpoints of the two lines.

8. Select the Smart Dimension tool from the 
Tools palette.
5



Ashlar-Vellum Basic Geometric Constraints Tutorial

6

9. Dimension the vertical line by clicking once on the line itself to indicate what to 
dimension and then once to the left of the vertical line to identify where the 
dimension text should be placed. With the dimension still highlighted, type 100 
mm in the status line and press the ENTER or RETURN key. 
The dimension value in the drawing 
window is modified and the line’s 
length is resolved to 100mm.

Although the line’s length has 
been changed, the profile 
remains intact, so that all 
endpoints remain connected and 
tangency is maintained.

10. Dimension the uppermost horizontal 
line by clicking once on the line itself 
to indicate what to dimension and 
then once above the line to indicate 
where the dimension text is to be 
placed. Once again, with the 
dimension still highlighted, type 100 
in the status line and press the 
ENTER (Windows) or RETURN 
(Macintosh) key. As before, the 
dimension value is modified and the 
line’s length is resolved to 100 mm.

11. Select the Coincident tool from the 
Constraints palette.

12. Apply a coincident constraint between 
the midpoint of the vertical line and 
the origin of the sketch by clicking 
once on the vertical line and then 
once on its midpoint to indicate which 
element to constrain and at which 
point the constraint should be applied. 
Then click twice on the sketch origin 
to indicate which element to constrain 
the vertical line to and at which point. 
When the sketch origin is clicked for 
the second time the whole profile 
moves to take account of the coincident relationship which has just been 
added. 
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Although the profile has moved to resolve the new coincident constraint, the 
profile remains intact, so that all endpoints remain connected, tangency is 
maintained and dimensions remain unchanged. The color of the profile 
changes from blue to green, indicating that the sketch is now fully 
constrained so that all the lines and curves in the sketch, and their positions, 
are described by dimensions or relations, or both.

With Cobalt it is not necessary to fully dimension or define 
sketches before using them to create features. 

13. Exit the sketch mode by clicking on the Exit Sketch Mode 
button in the drawing window. 

14. Change the orientation of the view to trimetric by selecting 
Trimetric from the View menu. 

15. Select the Extrude Solid tool from the 
Solids palette. 

16. Extrude the sketch to form a solid by 
first selecting the sketch profile then 
selecting two points in the z axis. With the 
extrusion still highlighted, type 40mm in 
the status line Distance field and press the 
ENTER (Windows) or RETURN 
(Macintosh) key. 
The base extrusion is now complete.
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Creating the Rectangular Boss
1. To sketch the profile of the rectangular boss, select the Sketch Mode tool from 

the Constraints palette. 
2. Instead of selecting anywhere in the drawing 

window, as before, select the bottom face off 
the base extrusion. 
Once again, the Exit Sketch Mode button 
appears in the drawing window along with a 
sketch mode axis. Only the palettes which can 
be used within the sketch mode are displayed. 
Any geometry which does not lie on the sketch 
plane is dimmed and geometry which does lie 
on the sketch plane is displayed as normal. 

3. Select the Rectangle tool from the Tool 
palette 

4. Construct a rectangle from the bottom left-
hand corner of the base extrusion to some 
point along the right-hand edge of the 
extrusion. 
Click on the endpoint of one of the lines which 
make up the left hand corner of the base 
extrusion and then click somewhere along the 
length of the line which makes up the right 
hand edge of the base extrusion. Little H, V 
and Box symbols appear to denote that 
horizontal, vertical and coincident constraints 
have been applied to the rectangle. 

At this point constraints have not been applied between the geometry which 
makes up the rectangle and the edges of the base extrusion. 

5. Select the Coincident tool from the 
Constraints palette.
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6. Add a coincident constraint between the 
endpoint of the long edge of the rectangle 
and the endpoint of the rear edge of the 
base extrusion. 
Do this by clicking once on the line which 
makes up the long edge of the rectangle 
and then once on its endpoint to indicate 
which element to constrain and at which 
point the constraint should be applied. Then 
click once on the rear edge of the base 
extrusion and once on its endpoint to 
indicate which element to constrain the line 
to and at which point. 

7. Repeat this procedure for the opposite endpoint of the long edge of the 
rectangle and the opposite endpoint of the rear edge of the base extrusion. 

8. Select the Smart Dimension tool from the Tool 
palette. 

9. Using the Smart Dimension tool, first 
select the line which makes up the left-
hand short edge of the rectangle at it's 
midpoint and then click once to the left 
of the line to indicate where the 
dimension text to be placed. With the 
dimension still highlighted type 30mm 
in the status line and press the ENTER 
(Windows) or RETURN (Macintosh) 
key. The dimension value is modified in 
the drawing window and the line's 
length is resolved to 30mm. 

10. As the sketch is now complete and fully 
defined, exit the sketch mode by clicking on the Exit 
Sketch Mode button in the drawing window. 
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11. Select the Protruded Feature tool 
from the Solids palette. 

12. Extrude the sketch to form a solid 
by selecting the base extrusion solid, then 
the sketch profile and finally the two points in 
the z axis. With the extrusion still highlighted 
type 40mm in the status line distance field 
and press the ENTER (Windows) or 
RETURN (Macitosh) key. 
The rectangular boss is now complete.
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Creating the Cylindrical Boss 
1. To sketch the profile of the cylindrical boss, 

select the Sketch Mode tool from the 
Constraints palette and select the top face 
of the base extrusion. Once again the Exit 
Sketch Mode button appears in the Drawing 
window along with a set of sketch mode 
axis. 
Only the palettes which can be used within 
the sketch mode are displayed. Any 
geometry which does not lie on the sketch 
plane is dimmed and geometry which does 
lie on the sketch plane is displayed as 
normal. 

2. Select the Center Point Circle tool from the Tool 
palette 

3. Construct a circle with its center positioned 
on the center point of the arc which defined 
the cylindrical face of the base extrusion. 
This is accomplished by first moving the 
cursor over the edge of the cylindrical face 
to highlight the center point of the defining 
arc. Then click once on the highlighted 
center point and once again to define the 
radius of the circle. 

At this point constraints have not been 
applied between the circle and the 
edges of the base extrusion. 

4. Select the Concentric tool from the Constraints 
palette. 

5. Add a concentric constraint between the 
circle and the edge of the cylindrical face of 
the base extrusion by clicking once on the 
circle and then once on the edge of the 
cylindrical face to indicate which element to 
constrain and to what. 
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6. Instead of using a Smart Dimension to define the diameter of the circle, this 
time an Offset Constraint between the circle and the edge of the cylindrical 
face of the base extrusion. 

7. Select the Offset tool from the Constraints palette. 

8. Add the offset constraint by clicking once on 
the circle and then once on the edge of the 
cylindrical face to indicate which element to 
constrain and to what. With the offset still 
highlighted type 15mm in the status line 
Offset field and press the ENTER 
(Windows) or RETURN (Macintosh) key. 

9. As the sketch is now complete and fully 
defined exit the sketch mode by clicking on the Exit 
Sketch Mode button in the drawing window. 

10. Select the Protruded Feature tool from the 
Solids Palette. 

11. Extrude the sketch to form a solid by first 
selecting the base extrusion solid to which 
to add to, then select the sketch profile and 
finally select two points in the z axis. With 
the extrusion still highlighted type 40mm in 
the status line Distance field and press the 
ENTER (Windows) or RETURN 
(Macintosh) key.
The cylindrical boss is now complete.
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Creating the Counter Bore Hole 
The creation of the counter bore hole is a two step process, first the center of the hole 
needs to be defined using a constrained sketch and then the hole feature itself needs to 
be created. 

1. Select the sketch mode tool from the 
Constraints palette and select the top face 
of the cylindrical boss. 
Once again, the Exit Sketch Mode Button 
appears in the drawing window along with a 
set of sketch mode axis and only the palettes 
which can be used within the sketch mode 
are displayed. Any geometry which does not 
lie on the sketch plane is dimmed and 
geometry which does lie on the sketch plane 
is displayed as normal. 

2. Select the Point tool from the Tool 
palette. 

3. Click anywhere on the top face of the 
cylindrical boss to place the point.

At this point a constraint has not been 
applied between the point and the edge 
of the cylindrical boss.

4. Select the Concentric tool from the 
Constraints palette. 
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5. Add a concentric constraint between the 
point and the edge of the cylindrical boss by 
clicking once on the point and then once on 
the edge of the cylindrical boss to indicate 
which element to constrain and to what.

6. As the sketch is now complete and fully 
defined, exit the sketch mode by clicking on the Exit 
Sketch Mode button in the drawing window. 

7. Select the Hole tool from the Solids 
palette. 

8. Ensure that the hole type is set to a Counter Bore and the options in the 
message line are specified as in the picture below. 
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9. Using the Hole tool first select the top face of the cylindrical boss and then 
select the point just created. With the counterbore hole still highlighted, type 
20mm, 20mm and 40mm in the status line Diameter, Bore Depth and Bore 
Diameter fields respectively and press the ENTER (Windows) or RETURN 
(Macintosh) key. 

The part is now complete, however, to show the true power of constraints it is necessary 
to go back and make some modifications. 
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Modifying the Part 
1. Select Layer Manager from the Layout Menu.

2. Open the Sketches branch by clicking on the plus button next to the word 
Sketches, then open the branches for Sketch 1 and Sketch 2. Finally, click on 
the empty box to the left of the layer names for Dimensions 1 and Dimensions 
2 to display those layers. 
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3. Select the dimension at the rear of the component which currently reads 
100mm. Change this value to 80mm by typing 80mm in the status line and 
pressing the ENTER (Windows) or RETURN Macintosh) key. 

The base extrusion resolves to be 80mm wide, as does the rectangular boss 
which is driven by the coincident constraints applied between the long edge of 
the sketch rectangle that defines the boss and the edge of the base extrusion. 
The diameter of the cylindrical boss also decreases as it is driven by the offset 
constraint applied between the circle that defines the boss and the edge of the 
cylindrical face of the base extrusion. 

4. Select the dimension on the right hand side of the component which currently 
reads 100mm. Change this value to 150mm by typing 150mm in the status line 
and pressing the ENTER or RETURN key. 

The base extrusion resolves to be 150mm in length. The cylindrical boss and 
counter bore hole also remain concentric with the cylindrical face of the base 
extrusion as a result of the concentric constraints applied to both the circle 
which defines the cylindrical boss and the point on the top face of the 
cylindrical boss which defines the center of the counter bore hole. 
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Modifying The Part Using An Equation 
It is not only possible to drive a constrained component via manual modification of 
dimension values but it is also possible to modify a component using relationships 
between dimension values. 

In this case an equation can be used to add a relationship between the length of the 
component and the length of the rectangular boss so that the length of the rectangular 
boss is always 1/3 the length of the long edge of the base extrusion. 

1. Select Equations from the Window menu. 

2. Ensure that both the sketches drop down on the left and the variables drop 
down on the right are set to display all sketches and all variables.
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3. Enter D2/3 in the equation field for the variable D3 and then click on the Apply 
button. 
The value for D3 is resolves to 1/3 D2. 

Congratulations. You have just learned how to set up geometric constraints and 
equations within Cobalt to drive geometry. 
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